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Введение

Конвекция – это процесс переноса энергии потоками жидкости или газа. Конвективные движения являются неотъемлемыми элементами многих природных процессов, наблюдаемых в атмосфере и океанах Земли, а также течений, реализуемых в различных технологических устройствах. Это определяет большой интерес к экспериментальному и численному изучению конвективных процессов [4].
Однако изучение формирования подобных течений в эксперименте требуют больших временных и материальных затрат. В отличие от эксперимента, численный подход дает возможность варьировать ряд важных параметров задачи, таких как вязкость, угловая скорость вращения модели, существенно влияющих на формирование и поведение конвективных течений.
Цели данной работы: 
· провести численное исследование конвективных течений в программном комплексе ANSYS, формирующихся вследствие локализованного нагрева в цилиндрическом слое жидкости. Сравнить результаты расчетов в CFX и FLUENT для различных режимов течения, сравнить эти результаты с данными, полученными в эксперименте.
· провести аналогичные расчеты для конвективных течений, формирующихся вследствие стока через центральное отверстие в неподвижном цилиндрическом слое жидкости. Интерес к расчетам в неподвижном слое обусловлен появлением экспериментальных работ [5-7], в которых в близкой постановке пороговым образом происходило формирование вихря в области стока. Проведение трехмерных расчетов требует значительных вычислительных ресурсов, поэтому расчеты провели в осесимметричной постановке. Провести анализ численной схемы, построить численную модель в программных пакетах ANSYS CFX и ANSYS FLUENT, выявить наличие вихревых движений в неподвижной численных моделях.
Теория
1. Уравнения тепловой конвекции
Жидкость может находиться в механическом равновесии (т.е. в ней может отсутствовать макроскопическое движение), не находясь при этом в тепловом равновесии. Уравнение Эйлера для покоящейся жидкости, находящейся в однородном поле тяжести
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 - может быть удовлетворено и при непостоянной температуре в жидкости. При этом, однако, возникает вопрос о том, будет ли такое равновесие устойчивым. Оказывается, что равновесие будет устойчивым лишь при выполнении определенного условия. Если это условие не выполняется, то равновесие неустойчиво, что в результате развития возмущений приводит к появлению в жидкости беспорядочных течений, стремящихся перемешать жидкость так, чтобы в ней установилась постоянная температура. Такое движение носит название тепловой конвекции. Условие устойчивости механического равновесия является, другими словами, условием отсутствия конвекции. Конвекция наступает при нарушении следующего условия: 


[image: image2.wmf]p

c

T

g

dz

dT

b

<

-

,

где 
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 – удельная теплоемкость при постоянном давлении, 
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 – температурный коэффициент расширения;

т.е. если температура падает по направлению снизу вверх, причем ее градиент превышает по абсолютной величине указанное в условии значение.

Выведем уравнения, описывающие конвекцию [1]. Мы будем рассматривать жидкость как несжимаемую. Это значит, что давление предполагается достаточно мало меняющимся вдоль жидкости, так что изменение плотности под влиянием изменения давления можно пренебречь. Это существенно упрощает систему уравнений, описывающих конвекцию. Что же касается изменения плотности благодаря неравномерной нагретости жидкости, то этим изменением, конечно, нельзя пренебречь. Именно оно приводит к появлению сил, вызывающих конвекционное движение.

Модель, которая описывает конвекцию жидкости, как несжимаемую, называется моделью Буссинеска [2]. Соответствующие приближенные уравнения обычно называют уравнениями конвекции в приближении Буссинеска. 

В таком случае переменная температура записывается в виде 
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 есть некоторое постоянное среднее значение, от которого отсчитывается неравномерность температуры 
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 мало также и вызываемое им изменение плотности 
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где  
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 – температурный коэффициент расширения.

 В давлении же 
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 не будет постоянной. Это давление, соответствующее механическому равновесию при постоянных (равных 
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где координата z отсчитывается вертикально вверх.

Учитывая все  эти соображения, получаем полную систему уравнений, описывающих термогравитационную конвекцию несжимаемой жидкости в приближении Буссинеска:

Уравнение Навье-Стокса: 
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Уравнение теплопроводности:
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Уравнение непрерывности:
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где 
[image: image24.wmf]u

 – вектор скорости, 
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 – коэффициент кинематической вязкости, 
[image: image28.wmf]0

ρ
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 – коэффициент температуропроводности, 
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 – коэффициент теплопроводности, 
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 – удельная теплоемкость при постоянном давлении. 

Возвращаясь к допущениям, сделанным при выводе уравнений (1.2) – (1.4), отметим, что основным моментом в приближении Буссинеска является предположение о том, что  рассматривается в некотором смысле «слабая» конвекция: вызванные неоднородностью температуры отклонения плотности от среднего значения предполагаются настолько малыми, что ими можно пренебречь во всех уравнениях, кроме уравнения движения (1.2), где отклонение учитывается лишь в члене с подъемной силой. Разумеется, учет неоднородности плотности лишь в уравнении движения означает некоторую непоследовательность приближения Буссинеска. Однако сравнение результатов решения уравнений конвекции (1.2) – (1.4) с обширным экспериментальным материалом с определенностью свидетельствует о том, что эти уравнения достаточно хорошо отражают все важнейшие особенности тепловой конвекции в лабораторных масштабах. 

В частных случаях температура или тепловой поток могут быть заданы непосредственно на границах полости, которую заполняет жидкость. При этом уравнения и граничные условия будут содержать следующие параметры: характерную длину полости L, характерную разность температур Θ, время τ, характеризующее нестационарность внешних условий, и параметры жидкости ν, χ, gβ. Из этих величин можно построить 2 независимые безразмерные комбинации:
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– так называемые числа Рэлея (R), Прандтля (P). Число Прандтля зависит только от свойств самого вещества жидкости; основной же характеристикой конвекции как таковой является число Рэлея. 

Два течения подобны, если их числа R и P одинаковы. Теплопередачу при конвекции в поле тяжести характеризуют числом Нуссельта:
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 – коэффициент теплопередачи между твердыми телами и жидкостью, 
[image: image36.wmf]κ

 – коэффициент теплопроводности среды, l – характерный размер.

Конвективное движение может быть как ламинарным, так и турбулентным. Наступление турбулентности определяется числом Рэлея – конвекция становится турбулентной при очень больших значениях R.

Ламинарное течение – течение, при котором жидкость или газ перемещается слоями без перемешивания и пульсаций (то есть беспорядочных и быстрых изменений скорости и давления).

Турбулентное течение – явление, заключающееся в том, что при увеличении скорости течения жидкости или газа в среде самопроизвольно образуются многочисленные нелинейные фрактальные волны и обычные, линейные различных размеров, без наличия внешних, случайных, возмущающих среду сил и/или при их присутствии.

2. Уравнения движения

Рассмотрим движения несжимаемой вязкой жидкости с неизменными физическими свойствами. Уравнения, описывающие движение несжимаемой вязкой  жидкости, выражают сохранение массы и количества движения:
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Здесь 
[image: image37.wmf]u

 – скорость частицы, измеряемая в системе координат, вращающейся с постоянной угловой скоростью 
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 представляют соответственно радиус-вектор частицы, время,  давление, плотность, кинематическую вязкость и массовую силу, отнесенную к единице массы. Массовая сила предполагается консервативной 
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, так что ее вместе с центробежной силой и Р можно записать в форме редуцированного давления
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Это упрощает уравнение (2.2)
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Полная форма конвективного ускорения 
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 используется чаще, чем инвариантное векторное представление.

Уравнения движения в инерциальной системе координат  получаются из предыдущих уравнений, если положить в них 
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Формула 

[image: image43.wmf]rot

inert

r

u

u

+

´

W

=


связывает между собой скорости частицы в инерциальной и  вращающейся системах.
На твердых непроницаемых поверхностях вязкая жидкость должна двигаться вместе с этими поверхностями, так как скольжение вдоль них или пересечение их невозможно. Если поверхность проницаемая, можно задать нормальную компоненту скорости, но требование отсутствия скольжения или относительной  тангенциальной скорости остается в силе. В общем случае граничная  поверхность имеет части, равномерно вращающиеся с угловой  

скоростью 
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. По отношению к системе, вращающейся со скоростью 
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граничное условие на такой поверхности есть
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Постановка задачи завершается описанием начального поля скорости
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Задача, таким образом, состоит в том, чтобы решить уравнения (2.1) и (2.4) в фиксированной области с граничными условиями (2.5) и (2.6). 

Пусть  
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 характеризуют типичную длину, время и  относительную скорость движения частицы. Замена переменных 
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 их нормированными значениями 
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 позволяет привести уравнения к безразмерному виду:
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с соответствующими граничными условиями. (Значок Λ отмечает единичный вектор.) При этом появляются два важных безразмерных параметра: число Экмана
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и число Россби
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Первый является грубой мерой отношения типичной силы  вязкости к силе Кориолиса и есть, по существу, обратное число Рейнольдса. Подобно этом число Россби — отношение конвективного ускорения к ускорению Кориолиса — дает общую оценку  относительного значения нелинейных членов. Число Экмана очень мало в большинстве тех случаев, когда преимущественно проявляются эффекты вращения. Практически величина 10-5 является для него обычной и в последующем предположение Е << 1 используется без дальнейших оговорок. Число Россби  имеет порядок единицы или меньше; в линейной теории его значение принимается бесконечно малым. 
Безразмерное уравнение вихря во вращающейся системе есть
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где
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Тривиальное решение этих уравнений, 
[image: image51.wmf]u

 = 0, отвечает, конечно, нетривиальному состоянию твердого вращения, наблюдаемому во вращающейся системе. В инерциальной системе соответствующая размерная скорость есть просто 
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. Очевидно, что вязкая жидкость, заключенная в закрытый равномерно вращающийся сосуд стремится с течением времени к этому естественному состоянию жесткого вращения.
3. Элементы теории завихренности
Нужно будет различать абсолютный вихрь 
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, измеренный в инерциальной системе, и относительный вихрь 
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, измеренный в равномерно вращающейся системе. Они связаны соотношением
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Такое же различие устанавливается для циркуляции по замкнутому контуру
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Некоторое преобразование последнего интеграла приводит к форме
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(3.2)
Здесь 
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— проекция поверхности 
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, ограниченной контуром L, на плоскость, перпендикулярную вектору  
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Применение теоремы Стокса дает равносильное определение циркуляции
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(3.3)
Завихренность в некоторой точке пропорциональна мгновенному угловому моменту сферического элемента жидкости (жесткого) в этой точке. Разумеется, мгновенная угловая скорость частицы есть как раз 
[image: image64.wmf]a

w

2

1

. Линия в жидкости, повсюду касательная к 
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, называется вихревой линией; вихревые линии, проходящие через каждую точку малой замкнутой кривой, образуют вихревую трубку. Если площадь поперечного сечения трубки 
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 мала, величина 
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 имеет одно и то же значение повсюду вдоль трубки и называется ее  интенсивностью. Это следует из теоремы о дивергенции 
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(3.4)
примененной к объему вихревой трубки, заключенному между  сечениями 
[image: image69.wmf]1
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 и 
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. Согласно (3.3), этот результат равносилен  утверждению о том, что циркуляция по некоторому контуру,  опоясывающему боковую поверхность трубки, постоянна. Другое заключение, вытекающее из (3.4), состоит в том, что вихревые линии не могут начинаться или оканчиваться в жидкости, они либо замкнуты, либо оканчиваются на твердых границах. 

Структуру поля завихренности можно изобразить с помощью вихревых трубок равной интенсивности, пронизывающих среду. Положение каждой трубки задается ее центральной вихревой  линией. Плотность трубок в некотором месте пропорциональна  завихренности, возрастающей по мере сближения трубок. При  растяжении вихревой трубки постоянной интенсивности завихренность возрастает, компенсируя уменьшение площади поперечного сечения.
Аккуратная аппроксимация уравнения завихренности в инерциальном пространстве
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(3.5)
дает соотношение между конвективной скоростью изменения абсолютной завихренности (левая часть) и тремя процессами,  вызывающими это изменение (правая часть). Эти процессы в том порядке, как они записаны, есть растяжение и поворот вихревых линий, возникновение завихренности за счет изменения плотности и  диффузионный перенос завихренности от соседних элементов.
Ниже кратко сформулированы несколько классических теорем о завихренности невязких жидкостей.
Теорема Лагранжа утверждает, что если в невязкой среде с  постоянной плотностью поле завихренности равно нулю в начальный момент, то оно остается нулевым всегда, 
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. (Условия,  разумеется, исключают все способы возникновения завихренности.)
Теорема Кельвина вытекает из формулы для полного изменения циркуляции по замкнутому контуру, движущемуся вместе с жидкостью:
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(3.6)
Следовательно, если жидкость однородна или баротропна Р = Р (ρ) и диссипация отсутствует, то циркуляция по контуру,  движущемуся вместе с жидкостью, остается все время постоянной. 

Теорема Гельмгольца следует прямо отсюда и утверждает, что при тех же условиях вихревая трубка движется вместе с жидкостью и ее интенсивность остается постоянной. 

Эти важные теоремы, будучи записаны для вращающейся  системы координат, показывают, как изменяются относительная  завихренность и циркуляция под действием основного вращения.
Постановка задачи и метод решения
1. Свободная конвекция
Рассматривается цилиндрический слой жидкости. Полагается, что на верхней границе выполняется условие проскальзывания, на боковой стенке и на дне — условие прилипания (схематично исследуемая модель и циркуляция жидкости представлены на рисунке 1)
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Рис. 1. Схематичное изображение расчетной области и меридиональной циркуляции

В центральной части цилиндр нагревается за счет постоянного теплового потока; область нагрева показана на схеме черным прямоугольником. Отвод тепла осуществляется через свободную верхнюю границу, на которой, кроме проскальзывания, также задается постоянный поток тепла (отрицательный). Количество вводимого в слой тепла задается равным количеству тепла, отводимому с верхней границы.
Граничные условия:

Полагается, что на боковых стенках и дне выполняется условие прилипания
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На верхней границе – условие проскальзывания:
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На верхней границе и в области нагрева также задаются потоки тепла:
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(6)
2. Вынужденная конвекция
Рассматривается цилиндрический слой жидкости. Полагается, что на боковой стенке и на дне выполняется условие прилипания (схематично исследуемая модель представлена на рисунке 3)
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Рис. 2. Схематичное изображение расчетной области
Жидкость истекает из цилиндра через донное отверстие в центральной части (заштрихованная область на схеме). Втекает жидкость через свободную верхнюю поверхность, где задается постоянный поток жидкости. Расход втекающей в слой жидкости равен расходу истекающей жидкости.

Граничные условия:

Полагается, что на боковых стенках и дне без стока выполняется условие прилипания
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На верхней границе и в области стока задаются значения скорости:
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(8)
Исследуемые задачи решаются в осесимметричной постановке (не учитывается зависимость от азимутальной координаты φ), течение жидкости предполагается ламинарным и описывается системой управляющих уравнений в размерной формулировке, включающей:
– уравнение сохранения полной энергии  
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– уравнение количества движения
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– уравнение непрерывности
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В уравнениях (9–11) используются обозначения: 
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 – полная энтальпия при наличии вращения; ω — угловая скорость вращения жидкости; r – радиус-вектор; λ – коэффициент теплопроводности; ρ – плотность жидкости; p – давление; U – вектор скорости; T – температура; τ – тензор вязких напряжений; 
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 – член, учитывающий силу Кориолиса и центробежную силу; 
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 – источник импульса, образованный силами плавучести; β – коэффициент объемного расширения; g – вектор гравитационного ускорения; 
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 – источник энергии.

Для численной реализации задачи в описанной постановке использовались конечно-элементные программные комплексы ANSYS CFX и ANSYS FLUENT. Принятые допущения об осевой симметрии задачи и ламинарном характере течения позволили значительно сократить количество расчетных узлов и время вычислений.
Рабочая среда ANSYS CFX
ANSYS CFX – мощный инструмент для оптимизации процесса разработки и технологической подготовки в области вычислительной динамики жидкостей и газов. ANSYS CFX совмещает в себе передовую технологию решателя с современным пользовательским интерфейсом и адаптивной архитектурой, что делает этот инструмент доступным как для разработчиков, владеющих общими инженерными знаниями, так и для специалистов в области гидродинамики, работающими с моделью и ее свойствами на глубоком уровне. CFX позволяет детально изучить оборудование и процессы изнутри, повысить эффективность, увеличить срок службы и оптимизировать процессы.

ANSYS CFX и ANSYS Workbench

Модуль ANSYS CFX полностью интегрирован в расчетную среду ANSYS Workbench - платформу, объединяющую все инструменты инженерного моделирования компании ANSYS. Адаптивная архитектура позволяет пользователю выполнять любые действия от стандартного анализа течения жидкости или газа до обработки сложных взаимодействующих систем. Пользователи могут легко оценить производительность во множественных расчетных точках или сравнить несколько альтернативных конструкций. Для решения задач из различных расчетных дисциплин в рамках платформы ANSYS Workbench можно получить доступ к общим для всех расчетов инструментам, таким как инструменты для работы с геометрией ANSYS DesignModeler и с сеткой ANSYS Meshing.

Геометрия: модуль ANSYS DesignModeler специально разработан для создания геометрии, ее подготовки к моделированию. Эта полностью параметрическая среда является простой в использовании, обладает прямыми и двусторонними связями со всеми основными CAD-пакетами и используется как средство согласования и ввода геометрии во все программные продукты ANSYS для последующих инженерных расчетов.

Создание сетки: для получения точных результатов расчетов в области вычислительной динамики жидкостей и газов необходима самая совершенная технология создания сетки. ANSYS Meshing предоставляет множество технологий построения сетки в одном приложении. Это дает возможность выбрать наиболее подходящий способ построения сетки на основе применения подхода последовательного построения сетки на каждой из деталей сборки.

Предобработка в CFX-Pre
Физический препроцессор ANSYS CFX - это современный, интуитивно понятный интерфейс для подготовки к моделированию динамики жидкостей или газов. В дополнение к основному режиму работы встроенный мастер помогает пользователю пройти процесс подготовки общих расчетов течения жидкостей или газов.

Мощный язык программирования дает возможность задать описание проблемы в числовом виде, как в случае со сложными граничными условиями, авторскими моделями материалов или дополнительными уравнениями переноса. Адаптивная архитектура CFX-Pre также позволяет пользователю создавать собственные панели графического пользовательского интерфейса, чтобы стандартизировать ввод для выбранных приложений.

Решатель ANSYS CFX-Solver
Сердцем модуля ANSYS CFX является передовой алгебраический многосеточный сопряженный решатель, использующий технологию Coupled Algebraic Multigrid, являющуюся ключом к получению точных результатов в короткие сроки. Параметры решателя, граничные условия могут быть скорректированы во время выполнения расчета, при этом нет необходимости останавливать решатель. Решатель ANSYS CFX использует схему дискретизации второго порядка по умолчанию, обеспечивая получение максимально точных результатов.

Использование технологии сопряженных решателей ANSYS CFX дает значительные преимущества при проведении любого расчета и позволяет получить устойчивые и масштабируемые решения для задач динамики жидкостей и газов. 

Постобработка в ANSYS CFD-Post

Постпроцессинг результатов графического и количественного анализа, полученных в ANSYS CFX, выполняется в ANSYS CFD-Post. Возможность написания сценариев, полная автоматизированность, генерация отчетов дают пользователю максимальное количество информации, полученной в результате расчетов. 

Рабочая среда ANSYS FLUENT
Программный модуль ANSYS FLUENT имеет широкий спектр возможностей моделирования течений жидкостей и газов для промышленных задач с учетом турбулентности, теплообмена, химических реакций. К примерам применения FLUENT можно отнести задачи обтекания крыла, горение в печах, внешнее обтекание нефтедобывающих платформ, течение в кровеносной системе, конвективное охлаждение сборки полупроводника, вентиляция в помещениях, моделирование промышленных стоков. Специализированные модели горения, аэроакустики, вращающихся/неподвижных расчетных областей, многофазных течений серьезно расширяют области применения базового продукта.

ANSYS FLUENT - это удобный, отказоустойчивый инструмент, позволяющий даже новичкам достигать высокой производительности труда. Интеграция модуля ANSYS FLUENT в рабочую среду ANSYS Workbench, а также возможность использования модуля ANSYS CFD-Post для обработки результатов создает комплексное решение для выполнения инженерного анализа в области моделирования течений жидкостей и газов.

Технология ANSYS FLUENT является лидером по числу сложных физических моделей, предлагаемых для расчетов на неструктурированных сетках. Представлены наборы элементов различных форм: четырехугольники и треугольники для двумерных расчетов, гексаэдры, тетраэдры, полиэдры, призмы, пирамиды для трехмерных расчетов.

Сетки можно строить при помощи инструментов компании ANSYS или при помощи инструментов сторонних производителей.

ANSYS FLUENT включает в себя сложные числовые отказоустойчивые решатели, в том числе сопряженный решатель с алгоритмом на основе давления, расщепленный решатель с алгоритмом на основе давления и два решателя с алгоритмами на основе плотности, что позволяет получать точные результаты для практически любого течения.

Сеточный генератор GAMBIT
FLUENT предлагает универсальное решение для создания расчетных сеток любых типов — набор программных продуктов, состоящий из GAMBIT, Tgrid и G/Turbo. Последний является своеобразным аналогом TurboGrid, но значительно уступает ему по функциональным возможностям. Отметим, что в отличие от ANSYS CFX, FLUENT поддерживает некомфорные сетки, сгенерированные в GAMBIT.

Качество получаемых на основе проведения вычислительного эксперимента результатов напрямую зависит от качества построенной расчетной сетки. Предпроцессор GAMBIT позволяет быстро создавать и обрабатывать геометрии исследуемых процессов. GAMBIT имеет единый интерфейс для создания геометрических моделей и построения сетки. Кроме того, в процессе его использования производится запись всех операций построения в текстовый файл (журнал событий), что дает возможность пользователю легко отслеживать путь создания геометрической модели, исправлять ошибки, перестраивать модели и сетки, а также интегрировать результаты в другие программы.

GAMBIT может импортировать геометрию из различных CAD программ. Часто во время импорта геометрии возникают проблемы нестыковки объектов. GAMBIT имеет встроенный модуль поиска и исправления подобных проблем, что значительно упрощает процесс создания модели.

GAMBIT обладает мощными возможностями для создания двухмерных и трехмерных расчетных областей непосредственно внутри программы, начиная от построения линий и сплайнов, кончая созданием твердотельных объектов. Встроенный специализированный модуль G/Turbo позволяет автоматизировать создание геометрических моделей лопаточных машин.

GAMBIT обладает мощным генератором сеток, позволяющим создавать разнообразные типы сеток: структурированную гексаэдальную сетку, автоматическую (неструктурированную) гексаэдальную и тетраэдальную сетки. Кроме того, в нем имеется возможность создания пограничных слоев с комбинированными сетками. После построения сетки пользователь имеет возможность проверить ее качество по разнообразным параметрам (скошенность элементов, соотношение сторон).

ANSYS CFX и ANSYS FLUENT
ANSYS CFX и ANSYS FLUENT – это основные продукты для задач гидрогазодинамики общего назначения, предлагаемые компанией ANSYS, Inc.

Оба решателя разрабатывались в течение десятилетий независимо друг от друга и обладают несколькими существенными отличиями, несмотря на некоторые схожие черты. Оба модуля основаны на методе контрольных объемов, дающем высокую точность, и используют решатель по давлению, что позволяет применять эти продукты для решения широкого круга инженерных задач. Основные отличия состоят в способе интегрирования уравнений течения жидкостей и в стратегиях решения уравнений.

Решатель ANSYS CFX использует сетку конечных элементов (числовые значения в узлах сетки), схожую с теми, что используется в анализе прочности, для дискретизации области. В отличие от ANSYS CFX, решатель  ANSYS FLUENT использует сетку конечных объемов (числовые значения в центрах ячеек). В итоге оба подхода формируют уравнения для конечных объемов, которые обеспечивают сохранение значений потока, что является необходимым условием для точных решений задач гидрогазодинамики. В ANSYS CFX особый упор сделан на решение основных уравнений движения (сопряженная алгебраическая сетка), а ANSYS FLUENT предлагает несколько подходов к решению (метод на основе плотности, расщепленный метод на основе давления, сопряженный метод на основе давления). Оба решателя содержат в себе самые ценные возможности физического моделирования для получения максимально точных результатов.
Этапы решения задачи в ANSYS CFX
Запускаем программную платформу ANSYS Workbench. В левой панели инструментов «Системы анализа» (Analysis Systems) выбираем анализ Fluid Flow (CFX). В рабочей области «Project Schematic» появится модуль в виде структурной схемы, в которой каждому этапу соответствует раздел, содержащий объекты расчетной модели:
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Для каждого объекта возможен ввод и редактирование свойств.
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Рис. 4.Схематический вид готового проекта в среде ANSYS Workbench

Создание геометрической модели в ANSYS DesignModeler

Для создания новой геометрической модели нужно нажать правой кнопкой мыши «Geometry» в структурной схеме модуля Fluid Flow (CFX) (Рис. 3). Появится контекстное меню, которое позволяет создать новую геометрию «New Geometry», импортировать данные геометрии, передать существующую геометрии в другие системы анализа для работы в исходном проекте, стереть данные, просмотреть свойства геометрической модели. Выбрав «New Geometry» в контекстном меню откроется программа для работы с геометрией ANSYS DesignModeler.

После открытия DesignModeler сразу появится диалоговое окно с выбором единицы измерения длины. Расчет будем проводить в миллиметрах.


Графический интерфейс программы состоит из окон с графиком модели 3D «Graphics», со схемой модели «Tree Outline», с детальным обзором функций «Details View», и с разнообразными панелями инструментов. Аналогична организация графического интерфейса других программ, которых мы будем использовать в дальнейшем. 
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Рис. 5.Схематический вид начального проекта в ANSYS DesignModeler
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Создание геометрической модели начнем с построения точек. Для этого в главной панели нажимаем Create -> Point [image: image94.png]@ Point



. В нижнем левом окне «Details View» появятся функции для детального задания точки (Рис. 6). Выбираем тип точки «Construction Point», задание точки через координаты «Manual Input». Вводим значения координат в соответствующие поля. Для добавления новой точки следует нажать правой кнопкой мыши и выбрать «Add New Point Group». После того, как ввели все нужные точки нужно нажать кнопку «Generate» [image: image95.png]“J Generate



 . Чтобы сгенерировались все введенные точки. Это следует делать всякий раз при добавлении нового геометрического элемента.

Далее нужно создать прямые линии для соединения точек. Для этого в главной панели нажимаем Concept ->Lines From Point [image: image96.png]s Lines From Points



. Удерживая мышкой клавишу «Ctrl», соединяем нужные точки в графической области. В окне «Details View» в поле «Operation» выбрать «Frozen». 
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После этого строим поверхность через созданные линии. Для этого в главной панели нажимаем Concept->Surfaces From Edges [image: image97.png]@ Surfaces From Edges



 . Удерживая мышкой клавишу «Ctrl», выбираем линии в графической области.
Теперь нужно сделать копию этой поверхности, повернутую относительно вертикальной оси Y. Для этого в главной панели нажимаем Create ->Body Operation [image: image98.png]1§ Body Operation



. В окне «Details View» выбираем поверхность, которую хотим повернуть, тип операции «Rotate», сохранение исходной поверхности, ось, относительно которой поворот, и угол поворота. 

Так как наша задача осесимметричная, угол берется минимальным для уменьшения времени расчета, путем уменьшения количества узлов в сеточной модели.

Чтобы связать поверхности, аналогичным образом используем операции [image: image99.png]s Lines From Points



 и [image: image100.png]@ Surfaces From Edges
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Для создания объема воспользуемся функцией [image: image101.png]1§ Body Operation



. В окне «Details View» выбираем все поверхности для «сшивки», тип операции «Sew», слияние всех поверхностей «Merge Bodies», «Create Solids».

В итоге получили геометрическую модель задачи (Рис. 8). 
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Следует заметить, что наши поверхности не проходят через центр координат,  мы берем отступ в 1 мм. Причина этого в том, что решатель выдает плохие результаты в центре координат. 



Закрываем DesignModeler, все данные по геометрии автоматически сохраняются в проекте Workbench. Можно переходить к следующему этапу – создание сеточной модели.

Создание сеточной модели в ANSYS Meshing
Для создания новой сеточной модели следует выбрать «Mesh» в структурной схеме модуля Fluid Flow (CFX) (Рис. 3). В открывшейся программе 
Meshing в «Outline» выбрать «Mesh» – в нижней части программы «Details of Mesh» появятся опции для работы с сеткой. 

Инструменты для создания сетки позволяют генерировать сеточные модели для разных типов анализа. Во вкладке «Defaults» выбираем метод вычислительной гидрогазодинамики «CFD», решатель «CFX». 
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Качество сеточной модели влияет на точность, сходимость и скорость получения решения. Пространственное разрешение возьмем 1 мм. Тестирование показало, что дальнейшее сгущение расчетной сетки не влияет на результаты. ANSYS Meshing позволяет задавать особые настройки сетки в требуемой зоне модели используя команду Mesh Control -> Sizing [image: image102.png]


. Для нас же представляет наибольший интерес поверхности симметричные относительно вертикальной оси. Во вкладке «Sizing» выбираем минимальное и максимальное разрешение сетки «Min Size», «Max Size». Для применения настроек сетки нужно нажать кнопку «Update» [image: image103.png]</ Update



. Во вкладке «Statistics» можно посмотреть полученные числа узлов и элементов.

Закрываем ANSYS Meshing, переходим к следующему этапу CFX-Pre.

Предобработка в CFX-Pre
ANSYS CFX-Pre реализует процесс определения физики задачи. Физический препроцессор импортирует сетку, созданную на предыдущем шаге. Это следующий шаг постановки задачи, на котором определяются физические модели, на основе которых будет происходить симуляция процесса, а также их основные параметры и характеристики. CFX-Pre позволяет определить начальные и  граничные условия процесса (входные, выходные параметры), модели теплообмена.

Чтобы открыть программу, следует выбрать «Setup» в структурной схеме модуля Fluid Flow (CFX) (Рис. 3)

Главным моментом в определении физики задачи является выбор типа анализа «Analysis Type»[image: image104.png]@© Analysis Type



 в окне «Outline». Мы решаем задачу нестационарную, поэтому выбираем тип анализа «Transient». Так же тут задается полная продолжительность физического процесса «Total time», шаг времени «Timesteps» и начальное время «Initial Time» (Рис. 12). 
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Параметры расчетной области
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Чтобы задать параметры для всей расчетной области нужно создать домен, выбрав Insert -> Domain[image: image105.png]


 в панели главного меню. Откроется окно с деталями. 

[image: image178.png]BasicSettngs | Material Properties

Thermodnanic Propertes
Equatonof state

Moar Mass 10 Bglmol-1]
Density 0 lgn~3]

‘SpecificHeat Capacity
Speciic Heat Capacity 1870 [1kg™-1K-1]

SpecicreatTipe

Reference State

RefTemperatre  20[]

Reference Pressure 1 [atm]

0.00671 Pas]

0.108 Wm~-1K~-1]

Buoyancy Propertes
Thermal Expansivity  0.0006 [~-1]




Во вкладке «Basic Settings» выбираем нашу расчетную область в поле «Location» (Рис. 11). Задаем тип расчетной области – жидкость «Fluid Domain». Вещество – вода («Material» – «Water»). Давление всей области «Preference Pressure» – 1 atm. Указываем, что конвекция есть «Buoyancy Model» – «Buoyant», т.е. задаем ускорение свободного падения против оси Y (Gravity Y Dirn. = –9.8). Buoy.Ref. Temp=20 [C]. 

Если требуется задать вращение модели в поле «Domain Motion» следует выбрать «Rotating», ввести угловую скорость вращения и ось, относительно которой вращается модель.

Переходим во вкладку «Fluid Models». Во вкладке «Heat Transfer» выбираем изотермический процесс «Isothermal». Рассматриваем ламинарное течение «Laminar», без окисления и радиации.

Для определения начальных условий переходим во вкладку «Initialization». Определяем начальные значения для компонентов вектора скорости, относительное давление «Relative Pressure» выбираем равным нулю, начальную температуру жидкости – 20 [C]. Нажимаем кнопку ОК. 

[image: image179.png]
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Для использования другого вещества (масла) в качестве жидкости следует выбрать Insert -> Material в панели главного меню [image: image106.png]\C) Material



. 

В появившемся окне деталей во вкладке «Basic Settings» выбираем тип вещества – чистое вещество «Pure Substance», группу жидкостей с постоянными свойствами «Material Group» – «Constant Property Liquids», термодинамическое состояние «Thermodynamic State» выбираем жидким «Liquid».  Переходим во вкладку «Material Properties», чтобы задать свойства материала (Рис. 12). В поле «Equation of State» задаем значение молярной массы и плотности вещества. В поле «Specific Heat Capacity» – удельную теплоемкость. В поле «Reference State» – значения для температуры и давления. В поле «Transport Properties» – значение динамической вязкости «Dynamic Viscosity» и коэффициент теплопроводности «Thermal Conductivity». В «Buoyancy Properties» – коэффициент теплового расширения «Thermal Expansivity».

Граничные условия

Для создания нового граничного условия нужно выбрать Insert -> Boundary [image: image107.png]¢ Boundary



. Появится окно для задания параметров граничного условия. Во вкладке «Basic Settings» выбираем тип «Boundary Type» и область граничного условия. Во вкладке «Boundary Details» выбираем параметры для массы и моментов потока жидкости «Mass And Momentum» и тип теплопередачи «Heat Transfer».
Тепловая конвекция:

В области с нагревателем задается условие прилипания и  положительный поток тепла «Heat Flux» [W/m2] – мощность нагрева 30 Вт, поделенная на площадь нагреваемой области.

Начнем с того, что зададим граничное условие на внешней боковой стенке. Выбираем область и задаем тип граничного условия – стенка «Wall».  Условие прилипания – «No Slip Wall», нулевой поток тепла – «Adiabatic».

На внутренней боковой стенке и на части дна без нагревателя такие же граничные условия.
На верхней области задается условие проскальзывания «Free Slip Wall» и отрицательный поток тепла «Heat Flux» [W/m2] – мощность нагрева 30 Вт, поделенная на площадь охлаждаемой области.
Вынужденная конвекция:

Зададим граничное условие на внешней боковой стенке. Выбираем область и задаем тип граничного условия – стенка «Wall». Вращающиеся стенки «Frame Type» – «Rotating». Условие прилипания – «No Slip Wall». 

На внутренней боковой стенке и на части дна вне отверстия такие же граничные условия.
В области стока жидкости в центральной части модели задается тип граничных условий – «Inlet». Задаем вращение – «Rotating». И указываем величину скорости, нормальной к области.
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В области истока жидкости в верхней части модели задается тип граничных условий – «Inlet». Задаем вращение – «Rotating». И указываем величину скорости, нормальной к области.

Для реализации осесимметричной постановки задачи надо задать граничные условия на поверхностях, симметричных относительно вертикальной оси. Нужно выбрать Insert -> Domain Interface [image: image108.png]#2  Domain Interface



. 

В открывшемся окне выбираем тип условия «Interface Type» – «Fluid Fluid». Выбираем соответствующие поверхности. Для задания симметрии относительно оси, выбираем опцию «Rotational Periodicity» и ось симметрии Y. 

В итоге получили физическую модель нашей задачи (Рис. 13).

CFX-Pre также позволяет настроить параметры для вывода данных. Для этого следует перейти в окне «Outline» в «Output Control» [image: image109.png]


. В случае нестационарной задачи панель управления выводом позволяет управлять, какие данные будут записываться в файлы вывода и с каким промежутком времени. Результаты могут быть написаны на особых стадиях решения при записи резервных файлов после заданного числа итераций. Данные мониторинга позволяют также показывать процесс решения задачи  в реальном времени. 

Для записи результатов в определенные моменты времени следует перейти во вкладку «Trn Results», добавить новый элемент (item), и выбрать нужные параметры для записи «Output Variables List». Также следует указать интервал времени между записями «Time Interval». Нас интересуют компоненты скорости, и полная температура с интервалом в 1 секунду. Закрываем CFX-pre.

Запуск решения в ANSYS CFX-Solver Manager
[image: image184.png]


CFX-Solver Manager представляет собой графический интерфейс пользователя, который позволяет задавать параметры для вычислений: управлять процессом решения CFX-Solver в интерактивном режиме, определять входные данные файла решателя, запускать или приостанавливать CFX-Solver, контролировать процесс решения задачи, устанавливать решатель для проведения параллельных вычислений. 

[image: image185.png]


Чтобы открыть его, в окне Workbench следует выбрать «Solution» в структурной схеме модуля Fluid Flow (CFX) (Рис. 3). В появившемся диалоговом окне можно настроить некоторые параметры решения задачи и запустить CFX-Solver Manger.

После завершения вычислений будет записан общий файл результатов и файлы интересующих нас параметров (компоненты скорости и полная температура) для заданных моментов времени. Это основные данные, которые будут использованы и обработаны в CFD-Post. 

CFX-Solver Manger может интерполировать решение данных текущей сеточной модели на новую сеточную модель. Также позволяет экспортировать файл результатов в другие форматы данных.

Можно закрывать CFX-Solver Manger и переходить к обработке данных в CFD-Post .

Постобработка в ANSYS CFD-Post

ANSYS CFD-Post – это программа, предназначенная для анализа, визуализации и представления результатов, полученных в ходе решения задачи посредством ANSYS CFX-Solver. Для этого используются следующие средства:
· визуализация геометрии и исследуемых областей;

· векторные графики для визуализации направления и величины потоков;

· визуализация изменения скалярных величин (такие как температура, давление) внутри исследуемой области.

Графики, изображения и видео, полученные в результате анализа решения задачи можно сохранить в виде отдельных файлов.

Чтобы открыть CFD-Post, в окне Workbench следует выбрать «Results» в структурной схеме модуля Fluid Flow (CFX) (Рис. 3). 
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Для начала введем график линий уровня с использованием цветной градиентной заливки «Contour Plot»  на интересующую нас поверхность, выбрав Insert -> Contour [image: image110.png]


.  С помощью «Contour Plot» можно будет посмотреть изменение какой-либо физической величины в данной области. 

В окне «Details» следует выбрать область и переменную для построения графика. Так же можно выбрать число контуров прорисовки для точности.

Для того чтобы посмотреть поле температуры в конкретный момент времени, следует перейти в Tools -> Timestep Selector [image: image111.png](@ Timestep Selector



 и выбрать момент времени из списка. 

Для наблюдения за изменением процесса во времени есть функция, позволяющая делать анимации. Надо перейти в Tools -> Animation [image: image112.png]Animation



 . В открывшемся окне нужно выбрать объекты для анимации «Timesteps», можно регулировать скорость анимации, количество просмотров, и сохранить анимацию в различных форматах видео.

Также можно поменять настройки цветовой шкалы «Legend»: изменить расположение шкалы в окне просмотра «3D Viewer», выбрать переменную, формат текста и прочее. 

CFD-Post позволяет построить график зависимости какой-либо величины от времени в некоторой точке. 

Чтобы добавить точку, нужно выбрать в панели главного меню Insert -> Location -> Point [image: image113.png]Paint



. В окне «Details», выбрав метод «Method» определения точки (через координаты «XYZ» или по номеру узла), ввести соответствующие значения. Так же можно определить форму, цвет и размеры точки. 

[image: image188.png]
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Чтобы добавить график, следует выбрать Insert -> Chart [image: image114.png]B chart



. В окне «Details» во вкладке «General» надо выбрать тип графика «XY – Transient» (т.е. зависимость от времени), добавить заголовок графика. В следующей вкладке «Data Series» в поле «Location» выбрать точку наблюдения температуры. Во вкладке «Y Axis» в качестве переменной «Variable» выбрать интересующую нас величину. Нажав кнопку «Apply», построится график зависимости от времени в точке. Нажав кнопку «Export», можно экспортировать данные в точке в качестве таблицы значений.
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Функция экспорта данных CFD-Post позволяет экспортировать значения необходимых переменных в каждом узле в интересующей области в один определенный момент времени. Формируется текстовый документ с колонками значений в каждом узле. Для этого надо выбрать File -> Export -> Export… [image: image115.png]


. Откроется окно с параметрами экспорта (Рис. 17), где во вкладке «Option» можно указать название и формат файла вывода, интересующую область модели и требуемые переменные. Во вкладке «Formatting» можно выбрать точность значений, а также определить тип разделителя для колонок в файле вывода.

Эта функция экспорта позволяет экспортировать файл данных только для одного конкретного момента времени. Чтобы экспортировать файл данных для всех моментов времени, следует использовать функцию сессий, иначе потребуется вручную делать экспорт файлов данных для каждого момента времени. 

Принцип работы сессий заключается в том, чтобы записать один сеанс работы в проекте ANSYS CFD-Post в виде программного кода на языке программирования CCL (ANSYS CFX Command Language) и использовать этот сеанс в цикле данного проекта или в других подобных проектах в ANSYS.

Для начала следует создать файл сессии. Для этого нужно перейти в Session -> New Session… [image: image116.png]


 и сохранить сессию в формате CFD-Post Session «*.cse». Чтобы начать запись сеанса, следует перейти Session -> Start Recording[image: image117.png]‘Start Recording



. С этого момента все действия в CFD-Post, в том числе и экспорт данных, будут записываться в созданный файл сессии. После проведения всех нужных действий для записи в файл сессии, нужно остановить запись, т.е. перейти Session -> Stop Recording [image: image118.png]Stop Recording



. Теперь можно просмотреть программный код записанной сессии, открыв файл сессии «*.cse» обычным текстовым редактором. Для изменения программного кода (добавления цикла) следует учитывать особенности синтаксиса языка программирования CCL. Добавив команду цикла и сохранив все изменения в программном коде файла сессии, следует «проиграть» эту сессию, выбрав Session -> Play Session…[image: image119.png]


. В результате выполнятся все команды, записанные в файл сессии, т.е. в цикле будут экспортированы файлы данных для каждого момента времени. 

Далее следует обработать полученные файлы данных, извлекая из них нужные значения и высчитывая соответствующие выражения. Для этого можно воспользоваться любым языком программирования, поддерживающим функцию чтения текстового документа. Мы же в этой работе будем использовать систему Wolfram Mathematica, которая позволяет импортировать полученные данные в свою систему в удобном формате, обрабатывать их и экспортировать результаты в виде таблиц и графиков. 

Программный код сессии с циклом и код программы, выполненный в системе Wolfram Mathematica, находятся в Приложениях.

Этапы решения задачи в ANSYS FLUENT 

Построение сеточной модели в GAMBIT
Качество получаемых на основе проведения вычислительного эксперимента результатов напрямую зависит от качества построенной расчетной сетки. GAMBIT имеет единый интерфейс для создания геометрических моделей и построения сетки.

Запускаем программу GAMBIT.

Начнем с построения геометрической модели.

1. Выберем кнопку «GEOMETRY COMMAND BUTTON»[image: image120.png]


. 

1.1. Далее, ниже, для создания точек выберем кнопки: [image: image121.png]


 → [image: image122.png]


.

Надо последовательно ввести соответствующие координаты точек в поля x, y, z и нажимать кнопку «Apply».

1.2. Для создания прямых линий перейти – [image: image123.png]


  → [image: image124.png]


.

Нажать кнопку [image: image125.png]


. В появившемся окне выбрать точки для их соединения и перенести в правую часть. Нажать «Apply».

1.3. Для создания плоскости следует перейти - [image: image126.png]


 → [image: image127.png]


.

Нажать кнопку [image: image128.png]


. В появившемся окне выбрать кнопку «All->». Нажать «Apply».

Построенную плоскость разбиваем на конечные элементы.

2. Выберем кнопку «MESH COMMAND BUTTON» [image: image129.png]


.

2.1. Выбираем опции для создания сетки на плоскости [image: image130.png]


 → [image: image131.png]


.

Нажав кнопку [image: image132.png]


, появляется окно, где надо выбрать нашу плоскость.

В поле «Interval Size» задается размер элемента. Нажать «Apply».

Задаем граничные условия на сторонах модели и тип среды.

3. Выберем кнопку «ZONES COMMAND BUTTON» [image: image133.png]


.

3.1. Для задания граничных условий следует выбрать кнопку [image: image134.png]


.

Нажимая кнопку [image: image135.png]


, в появившемся окне выберем соответствующую сторону. В поле «Type» выбираем тип граничных условий. Присваиваем имя для стороны в поле «Name». Нажимаем «Apply». Так следует проделать для всех сторон. В случае тепловой конвекции четыре стороны будут типа «WALL», одна сторона – ось симметрии – типа «AXIS». 

В случае вынужденной конвекции две стороны будут типа «WALL», одна сторона – ось симметрии – типа «AXIS», две стороны типа «VEL-OUTLET».

3.2. Для задания типа среды следует выбрать кнопку [image: image136.png]


.

[image: image192.png]


Нажимая кнопку [image: image137.png]


, в появившемся окне выберем соответствующую плоскость «Faces». Выбрать тип – жидкость «FLUID». Выбираем имя для нашей среды в «Name». Нажать «Apply».

Так мы построили сеточную модель нашей задачи. 

В ходе построения можно просмотреть нашу модель в разных плоскостях, нажав кнопку [image: image138.png]


 в нижней части панели инструментов. 
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Получившуюся сеточную модель нужно экспортировать. Для этого перейдем в главное меню File → Export → Mesh… . В появившемся окне выбрать название файла, поставить метку «Export 2D Mesh». Нажать «Apply».

В процессе построения модели производится запись всех операций в текстовый файл (журнал событий). Это позволяет использовать его как программный код. Для сохранения журнала событий надо перейти File → View File. В появившемся окне скопировать код в текстовый документ.

Программный код операций Gambit, находится в Приложениях. 
Построение физической модели в ANSYS FLUENT

Запускаем ANSYS FLUENT. 

Для того чтобы открыть файл сетки, следует выбрать в главном меню File → Read → Mesh.

Слева расположено основное меню для построения физической модели.

1) В разделе «General» основного меню задаются параметры решателя. В колонке «Solver» выбираем тип решателя «Pressure-Based», в «Time» нестационарный процесс «Transient», «Velocity Formulation» - «Absolute»,  осесимметричную задачу в «2D Space» - «Axisymmetric». Ставим метку «Gravity», задаем ускорение свободного падения против оси x.

2) В разделе «Models» задаем основные уравнения: «Energy» - On, «Viscous» - Laminar.

3) В «Materials» задаем свойство жидкости. Нажимаем кнопку «Create». В появившемся окне задаем свойства жидкости. Нажимаем кнопку «Create».

4) В разделе «Cell Zone Conditions» для нашей среды выбираем тип «fluid». В «Edit» выбираем нашу жидкость. 
Для того чтобы, задать вращение модели ставим галочку напротив «Frame motion». Задаем угловую скорость в поле «Rotational Velocity».

5) В «Boundary Conditions» задаем граничные условия на наши стороны.
Вынужденная конвекция: для этого нужно выбрать соответствующую сторону и  перейти по кнопке «Edit». Для зоны «Inlet» в поле «Momentum» следует выбрать метод задания скорости «Velocity Specification Method» – «Magnitude, Normal to Boundary». Нам нужно задать относительную скорость стока, поэтому в поле «Reference Frame» выбираем опцию «Relative to Adjacent Cell Zone». Теперь нужно задать величину скорости в «Velocity Magnitude».
Для зоны «Outlet» все также, только нужно выбрать абсолютную скорость в «Reference Frame» - «Absolute».
Свободная конвекция: перейдя по кнопке «Edit», откроется окно, где можно выбрать условие прилипания «No Slip», условие проскальзывания «Specified Shear», задать тепловой поток «Heat Flux» на соответствующих сторонах.
 6) В разделе «Reference Value» задаются исходные величины некоторых параметров: плотность, вязкость, температура. Так же следует выбрать нашу зону в «Reference Zone».

7) В «Solution Methods» выбираем опции решателя. Выбираем в «Pressure-Velocity Coupling» схему «Scheme» - «PISO». В «Spatial Discretization» выбираем для давления «Pressure» - «Presto!». Это наиболее подходящие опции для нашего течения.  

8) В «Solution Initialization» выбрать начальное значение температуры. Следует нажать кнопку «Initialize», чтобы установить начальное состояние задачи.

9) В «Calculation Activities» можно настроить экспорт данных по ходу решения задачи, выбрать интересующие параметры для вывода, указать директорию для записи.

10) В «Run Calculation» можно выбрать адаптивный или фиксированный типы шага, задать размер шага, число шагов. Для того чтобы запустить решение нужно нажать кнопку «Calculate».

По окончанию решения появится окно с уведомлением «Calculation completed».

Полученные данные можно просмотреть и обработать в постпроцессоре «CFD-Post», перейдя File → Export to CFD-Post.

Анализ численной схемы
В решение нашей задачи используется сеточный численный метод, основанный на дискретной аппроксимации уравнений. Основным требование, предъявляемым к таким сеточным методам, является, прежде всего, обеспечение высокой точности (малой численной ошибки) получаемых результатов при минимально необходимом вычислительном ресурсе.

Поэтому очень важно правильно выбрать параметры решения задачи, которые влияют на точность и длительность расчета данной численной модели. Основным параметром является шаг сетки. Нашей целью будет выбор такого шага сетки, чтобы относительная погрешность интересующих нас результатов не превосходила 1-2%.
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Рассмотрим модель вынужденной конвекции. Радиус модели составляет 20 см, толщина слоя – 20см, радиус области стекания жидкости – 2см. На верхней границе втекает жидкость со скорость 
[image: image139.wmf]inlet

U

. В нижней центральной части жидкость вытекает со скоростью 
[image: image140.wmf]outlet

U

. Схематично область моделирования изображена на рисунке 19.
Были получены результаты решения задачи для сеточных моделей с разными шагами сетки: 0.5 мм, 1 мм, 2 мм, 3 мм. График изменения средней кинетической энергии со временем, представленный на рисунке 20, показывает насколько отличаются результаты решения в зависимости от шага сетки. 
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Приняв за точное значение кинетической энергии при шаге сетки 0.5 мм, относительная погрешность для кинетической энергии при разных шагах сетки будет соответственно: 1 мм – 1.2 %, 2 мм – 3.2 %, 3 мм – 6.6 %. 
Таким образом, результат, полученный для модели с шагом сетки 1 мм, обладает высокой точностью, меньшим потреблением вычислительных ресурсов по сравнению с шагом сетки 0.5 мм и является оптимальным выбором для нашей задачи.
Результаты решения задачи свободной конвекции
Качественное описание формирования конвективного течения
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Были проведены расчеты для модели цилиндрического слоя жидкости с локализованным нагревом в центре. Радиус модели составляет 150 мм, толщина слоя – 30 мм, радиус нагреваемой области – 50 мм. 
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В случае подогрева жидкости в центре модели устанавливается режим течения,  схематически изображенный на рис. 21. Локальный нагрев в центральной части дна создает вертикальный и горизонтальный градиенты температуры. Горизонтальный градиент температуры приводит к образованию обратной меридиональной ячейки [5]. Течение в нижней части направлено к центру, а над центральной частью формируется интенсивное подъемное течение. В верхней части слоя радиальное движение направлено к периферии. Таким образом, происходит формирование адвективного течения.
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На фоне основного течения, который занимает весь слой, возникают вторичные движения в виде конвективных струй, которые уносятся основным потоком (Рис. 25). Они образуются около нагретой горизонтальной поверхности вследствие неустойчивого распределения температуры в пограничном слое. Существенное влияние на формирование вторичных  конвективных течений оказывает распределение температуры – горизонтальный градиент температуры. Набегающий вдоль дна поток холодной жидкости уносит с собой восходящие конвективные струи. Конвективные струи формируются на некотором расстоянии от края нагреваемой области, если тепловой поток поддерживается постоянным, то это расстояние практически не изменяется. Они возникают периодически по времени, частота их образования возрастает, а расстояние между точками возникновения уменьшается с ростом подводимого теплового потока.

Вторичные течения существенно влияют на процессы тепло-массобмена в пограничном слое, поэтому их исследование представляет большой интерес, как для фундаментальных, так и для прикладных задач.



Количественное описание формирования свободной конвекции
Результаты CFX
Были рассмотрены конвективные течения с постоянным локализованным нагревом для воды и масла. Физическое время расчетов 200 секунд, этого было достаточно для выхода на периодический режим. Начальная температура для обеих жидкостей 20 оС. Для каждой жидкости расчеты проводились при режимах с вариацией мощности нагрева P: 5 Вт 10 Вт, 20 ВТ, 30 ВТ, 40 ВТ, 50 ВТ. Были построены графики зависимости средней кинетической энергии, времени выхода в квазистационарное движение от мощности нагрева и график зависимости средней кинетической энергии от времени для всех режимов. Так же построен график, показывающий изменение периода появления конвективной струи в точке А (37.5 мм, 3.9 мм, 0 мм) в зависимости от мощности.

Сравнение результатов для режимов воды и масла
На рисунке 27 представлен график зависимости средней кинетической энергии от времени при разной мощности нагрева. Значение средней кинетической энергии в слое жидкости определяется следующим соотношением: 
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. График показывает, что увеличение мощности нагрева приводит к заметно более интенсивному конвективному течению жидкости. Так же видно, что с некоторого момента времени интенсивность течения начинает падать. Сравнивая графики средней кинетической энергии для воды и масла (Рис. 27), можно наблюдать, что течение воды более интенсивно по сравнению с течением масла. Так же наблюдая за поведением изменения кинетической энергии масла, можно увидеть, что оно происходит с некоторой периодичной пульсацией.

[image: image143]
Действительно, наблюдая за течением основного потока жидкости, можно увидеть, что со временем происходит установление периодического режима.

Из графика, представленного на рисунке 28, видно, что время установления периодического режима у воды больше чем у масла. 

 Время установления периодического режима t* было подсчитано вручную – были исследованы графики зависимости полной температуры от времени в точке А (Рис. 29), и найдены моменты времени, после которого колебания температуры периодически повторялись. Из этого графика (Рис. 28) видно, что t*  уменьшается с увеличением мощности нагрева  P.

Изменение средней кинетической энергии в зависимости от P происходит схожим линейным образом, единственное отличие заключается в том, что величина средней кинетической энергии в случае воды больше той же величины в случае масла.

Как было замечено ранее, конвективные струи возникают в фиксированных, регулярно расположенных точках поверхности, если тепловой поток поддерживается постоянным. Конвективные струи возникают периодически по времени.

Интересно рассмотреть поведение таких мелкомасштабных структур при разной мощности нагрева. Добавив точку наблюдения А в непосредственной близости к очагу образования конвективной струи, можно наблюдать изменение полной температуры в этой точке при разной мощности нагрева.
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Рисунок 33 иллюстрирует изменение частоты генерации мелкомасштабных структур от мощности нагрева в фиксированной точке А для воды и масла. Частота генерации мелкомасштабных структур в масле больше чем в воде.

Результаты FLUENT
Для режимов конвективного течения масла и воды во FLUENT получаются похожие результаты. 
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Рисунки 32 и 33 иллюстрируют изменение кинетической энергии со временем при разной мощности нагрева для масла и воды.  График для масла показывает, что периодическое колебание кинетической энергии происходит на высоких частотах – признак влияния мелкомасштабных структур, частота возникновения которых высока.

График для воды показывает, что колебания происходят с низкочастотными пульсациями, связанное с течением основного потока конвективной ячейки.
Сравнение результатов CFX и FLUENT с результатами эксперимента

В эксперименте были получены следующие значения частот генерации мелкомасштабных структур для масла при разной мощности нагрева.

	P, Вт
	5,7
	10
	15
	20,3
	26,3
	30
	35
	40
	45

	ν, 1/с
	0,068
	0,113
	0,146
	0,179
	0,211
	0,246
	0,282
	0,288
	0,314


Можно сравнить результаты эксперимента с результатами, полученными в CFX и FLUENT.
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Из графика, представленного на рисунке, видно, что значения частоты генерации мелкомасштабных структур, полученных в CFX и FLUENT, являются схожими. А экспериментальные данные хорошо согласуются с численными данными при малых мощностях нагрева и существенно различаются при высоких мощностях. Это объясняется тем, что с ростом нагрева реальное течение, исследуемое в эксперименте, теряет осесимметричность, а в двумерных расчетах мы навязываем условие осесимметричности. Таким образом, нужно переходить к трехмерным расчетам и искать механизм который обуславливает отличие осесимметричного случая и трехмерного, при этом в эксперименте необходимо проверить существование низкочастоных колебаний кинетической энергии основного течения.
Результаты решения задачи вынужденной конвекции
Были проведены расчеты для модели цилиндрического слоя жидкости со стоком в центре. Радиус модели составляет 20 см, толщина слоя – 20см, радиус области стока жидкости – 2см. 

В случае стока жидкости в центре модели, устанавливается режим течения,  схематически изображенный на рис. 36.
На рисунках 37 и 38 представлены мгновенные поля скорости течения в радиальном сечении в разных программных пакетах. 
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Были  проведены расчеты для разных режимов течения с вариацией скорости стока (м/с):  0,01, 0,02, 0,04, 0,08, 0,16. 
Нашей целью в данной постановке является определение наличия вихревых движений в слое жидкости. Для того чтобы выявить возникновение вихревых движений в зоне стока, были изучены поля азимутальной компоненты скорости в радиальном сечении. Результаты для всех режимов течения показали, что азимутальная компонента скорости во всем сечении равна нулю. Таким образом, в осесимметричной постановке задачи в неподвижном слое жидкости вихревые движения не возникают. Это означает, что это явление имеет трехмерную природу и нужно переходить к трехмерным расчетам для изучения вихревых движений в неподвижном слое жидкости.
Заключение
В данной работе были исследованы конвективные течения в  цилиндрическом слое жидкости с локализованным нагревом в центральной области в пакете ANSYS. Результаты проведенного исследования показали, что варьирование мощности нагрева в рамках используемой численной модели не приводит к существенным изменениям в структуре течений. От жидкости и  мощности нагревателя зависят только количественные характеристики: изменение интенсивности движения и частоты появления конвективной струи. С увеличением мощности нагрева увеличивается средняя кинетическая энергия течения, и частота появления вторичных структур в виде конвективных струй. 

В ходе решения задачи было проведено сравнение решений, полученных различными решателями CFX и FLUENT и экспериментом: значения частоты генерации мелкомасштабных структур, полученных в CFX и FLUENT, являются схожими. На масле и CFX и FLUENT хорошо согласуются с экспериментом, но только для малых мощностей нагрева. Таким образом, нужно переходить к трехмерным расчетам и искать механизм который обуславливает отличие осесимметричного случая и трехмерного.
Были исследованы конвективные течения в неподвижном цилиндрическом слое жидкости со стоком в центре. В осесимметричной постановке задачи в неподвижном слое жидкости вихревые движения не возникают. Это означает, что это явление имеет трехмерную природу и нужно переходить к трехмерным расчетам для изучения вихревых движений в неподвижном слое жидкости.
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Приложения

Программный код сессии CFD-Post Session «*.cse»
! for ($i=0; $i <= 200; $i++) {

> load timestep=$i*10

EXPORT:

ANSYS Export Data = Element Heat Flux

ANSYS File Format = ANSYS

ANSYS Reference Temperature = 0.0 [K]

ANSYS Specify Reference Temperature = Off

ANSYS Supplemental HTC = 0.0 [W m^-2 K^-1]

BC Profile Type = Inlet Velocity

Export Connectivity = Off

Export Coord Frame = Global

Export File = C:/Users/c3po/Desktop/Report/OIL_REPORT/30WOIL/30WOIL_test/test$i.txt

Export Geometry = On

Export Node Numbers = On

Export Null Data = On

Export Type = Generic

Export Units System = Current

Export Variable Type = Current

Include File Information = Off

Include Header = Off

Location List = Domain Interface 1 Side 1

Null Token = null

Overwrite = On

Precision = 8

Separator = " "

Spatial Variables = X,Y,Z

Variable List = Total Temperature, Velocity u, Velocity v, Velocity w

Vector Brackets = ()

Vector Display = Scalar

END

>export

!}

Код программы, выполненный в системе Wolfram Mathematica
n = 200;

For[i = 0, i <= n, i++,

  file[i] = StringJoin[{"E:\\Report\\WATER_REPORT\\30W\\30W_test\\", "test", ToString[i], ".txt"}];

table[i] = Import[file[i], "Table"]];

l = Length[table[0]];

For[i = 0, i <= n, i++, at[i] = Sum[table[i][[j]][[5]], {j, l}]/l]

temptab = Table[{i, at[i]}, {i, 0, 200, 1}];

Lt = ListPlot[temptab, Joined -> True, PlotRange -> Full, Ticks -> {Table[i, {i, 0, 200, 20}]}, AxesLabel -> {"s", K}, AxesStyle -> Directive[FontSize -> 22], AspectRatio -> 1/3, PlotStyle -> Directive[Thick], PlotLabel -> Style["Средняя температура", 28]];

Export["C:\\Users\\c3po\\Desktop\\Report\\OIL_REPORT\\50WOIL\\50WOIL_\temtab.gif", Lt, ImageSize -> {936, 396.5}];

Export["C:\\Users\\c3po\\Desktop\\Report\\OIL_REPORT\\50WOIL\\50WOIL_\temtab.txt", temptab, "Table"];

For[i = 0, i <= n, i++, 

 ae[i] = 10^7 Sum[\[Pi]*table[i][[j]][[2]] (table[i][[j]][[6]]^2 + table[i][[j]][[7]]^2 + table[i][[j]][[8]]^2)/l, {j, l}]];

entab = Table[{i, ae[i]}, {i, 0, 200, 1}];

Le = ListPlot[entab, Joined -> True, PlotRange -> Full, Ticks -> {Table[i, {i, 0, 200, 20}]}, AxesLabel -> {"s","10^7m^2/s^2"}, AxesStyle -> Directive[FontSize -> 22], AspectRatio -> 1/3, PlotStyle -> Directive[Thick], PlotLabel -> Style["Средняя кинетическая энергия", 28]];

Export["E:\\Report\\WATER_REPORT\\30W\30W_entab.gif", Le, 

  ImageSize -> {936, 396.5}];

Export["E:\\Report\\WATER_REPORT\\30W\\30W_entab.txt", entab, 

  "Table"];

Программный код Gambit

Created vertex: vertex.2

Command> vertex create coordinates 0 0.15 0

Created vertex: vertex.3

Command> vertex create coordinates 0.03 0.15 0

Created vertex: vertex.4

Command> vertex create coordinates 0.03 0 0

Created vertex: vertex.5

Command> edge create straight "vertex.1" "vertex.2"

Created edge: edge.1

Command> edge create straight "vertex.2" "vertex.3"

Created edge: edge.2

Command> edge create straight "vertex.3" "vertex.4"

Created edge: edge.3

Command> edge create straight "vertex.4" "vertex.5"

Created edge: edge.4

Command> edge create straight "vertex.1" "vertex.5"

Created edge: edge.5

Command> face create wireframe "edge.1" "edge.2" "edge.3" "edge.4" "edge.5" real

Created face: face.1

Command> window modify shade

Command> face mesh "face.1" map size 0.001

Mesh generated for face face.1:   mesh faces = 4500.

Command> physics create "heat" btype "WALL" edge "edge.1"

Created Boundary entity: heat

Command> physics create "bottom" btype "WALL" edge "edge.2"

Created Boundary entity: bottom

Command> physics create "side" btype "WALL" edge "edge.3"

Created Boundary entity: side

Command> physics create "top" btype "WALL" edge "edge.4"

Created Boundary entity: top

Command> physics create "axis" btype "AXIS" edge "edge.5"

Created Boundary entity: axis

Command> physics create "fluid" ctype "FLUID" face "face.1"

Created Continuum entity: fluid
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– постобработка в ANSYS CFD-Post





– решатель ANSYS CFX-Solver Manager





– предобработка в CFX-Pre





– создание сеточной модели в ANSYS Meshing





– создание геометрии в ANSYS DesignModeler





– название системы





Рис. 3. Структурная схема





Рис. 6. Окно добавления точек





Рис. 7. Окно «Body Operation»





Рис. 8. Геометрическая модель задачи





Рис. 9. Настройки сетки





Рис. 10. Выбор типа анализа





Рис. 11. Окно для выбора параметров расчетной области





Рис. 12. Свойства нового вещества





Рис. 13. Физическая модель





Рис. 14. Окно CFX-Solver Manager





Рис. 15. Мгновенное поле скорости в радиальном сечении





Рис. 16. График зависимости скорости от времени в точке





Рис. 17. Параметры экспорта данных





Рис. 18. Сеточная модель в Gambit





Рис. 19. Схематичное изображение области моделирования
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Рис. 20. Зависимость средней кинетической энергии от времени





Рис. 21. Схематическое изображение конвективного движения





Рис. 22. Мгновенное векторное поле скорости течения в радиальном сечении (область нагрева показана черной линией)





Рис. 23. Поле средней скорости течения в радиальном сечении





Рис. 24. Поле средней температуры течения в радиальном сечении





Рис. 25. Изолинии температуры и векторное поле скорости в радиальном сечении





а





б





Рис. 26. Положение точки А





Рис. 27. График зависимости средней кинетической энергии от времени при разной мощности нагрева для воды и масла (CFX)











Рис. 28. График зависимости времени выхода в установившееся течение t* от мощности нагрева P





Рис. 29. Зависимость полной температуры в точке А от времени (черной линией указано время перехода в периодический режим)





Рис. 30. График зависимости средней кинетической энергии в зависимости от мощности нагрева P для воды и масла





Рис. 31. Изменение частоты генерации мелкомасштабных структур ν в точке А от мощности нагрева Р (CFX)





Рис. 32. График зависимости средней кинетической энергии от времени при разной мощности нагрева для масла (FLUENT)








Рис. 33. График зависимости средней кинетической энергии от времени при разной мощности нагрева для воды (FLUENT)








Рис. 35. Изменение частоты генерации мелкомасштабных структур ν от мощности нагрева в т А от мощности нагрева Р





� EMBED Visio.Drawing.11  ���





Рис. 36. Схематичное изображение области моделирования





Рис. 37. Мгновенное поле скорости и векторное поле течения в радиальном сечении (скорость стока равна 0,04 м/с) во FLUENT





Рис. 38. Мгновенное поле скорости и векторное поле течения в радиальном сечении (скорость стока равна 0,04 м/с) в CFX
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